
How to display several full size models on one 
screen? (for Windows users) 

 

iStripper can operate in two modes: desktop mode and as a screen saver. The first of these is the mode in 

which models are displayed on your computer's desktop while you perform standard activities such as 

work, entertainment, surfing the Internet, etc. The second mode, the screen saver, can be activated after 

some time of inactivity. All windows and the desktop are hidden, and the so-called "stage" is displayed. This 

article is focused on the first of these modes - the desktop mode. 

When working in desktop mode, the user has the choice: 

 display models in full size (60% -200% of the size of the monitor) or 

 display models in small size (10% -60% of the size of the monitor). 

Each of these options has some limitations. When displaying a model in full size, only one show can be 

played. You can't view two models in full size. You can't change the position of the clip by dragging and 

dropping the model. Displaying models in small size, however, allows you to play one to ten shows at once, 

but here the limit is the size of the clips. You can't set their scale above 60% of the size of your monitor. 

Imagine now what your desktop would look like if not one, but at least two models danced at the same 

time, both in full size? Maybe you have several monitors plugged to your PC and you want to have a 

full-sized girl dancing on each of them at the same time? Unfortunately, iStripper does not provide this 

option. Fortunately, third-party applications come to the rescue. Although they have not been created for 

this purpose, they can be successfully used here. 

This article describes three methods to display several full-size girls on one or more monitors at the same 

time. Each method uses different software. The article is divided into three sections, each of them focused 

on separate method. Each method accurately describes how to download and install the program and tells 

you how to use it. Each method has been tested and works. The tests were performed using the 

following software: 



 Windows 7 operating system (64-bit) 

 iStripper 1.2.190 

 Sandboxie 5.24 (64-bit) 

 Process Explorer 16.21 (64-bit) 

 Cheat Engine 6.7 

NOTE: Remember that if you decide to use any method you take full responsibility for the activities 

performed. For any errors or irregularities related to the operation of any of the programs, as well as the 

Windows system, the responsibility lies with you. Neither the author of this article nor Totem 

Entertainment are responsible for the effects of your actions. 

Choose one of the available methods now or read each one and choose the one that suits you best: 

1. A new process in the sandbox - method using Sandboxie, 

2. Duplicating processes - method using Process Explorer, 

3. Editing RAM content - method using Cheat Engine. 

 

  



A new process in the sandbox - method using 
Sandboxie 

The method consists in running the iStripper program in two separate processes (two separate instances). 

Normally, this is not possible because only one iStripper instance can work in the system. An attempt to run 

another "copy" of the program usually ends with the recall of the window of the first copy that was 

launched. 

To be able to run another copy of iStripper, we will use the free version of Sandboxie. After its installation 

it will be possible to create the so-called "sandbox". The sandbox is a controlled environment in which the 

second copy of iStripper will be launched. Each application running in such environment (including 

iStripper) will not see other programs that work in the system in a normal way. The free Sandboxie version 

allows you to create only one sandbox, but it should be enough in many cases. 

Downloading Sandboxie 

To download Sandboxie open any web browser and go to: 

https://www.sandboxie.com/DownloadSandboxie 

Download the installation program by clicking on the image with the word "Sandboxie", marked on the 

following printscreen. 

 



Save the installer (SandboxieInstall.exe file) anywhere on your hard drive. 

Installation of the Sandboxie 

To install Sandboxie, open the folder where you downloaded the installer and double-click on the 

SandboxieInstall.exe file. In the first step select your preferred language. Select it from the list of available 

languages and click OK. 

 

Confirm the license terms by clicking the I Agree button. 

 

Select the path to the folder in which Sandboxie will be installed. The default path is: 



C:\Program Files\Sandboxie 

Leave it unchanged and click the Install button. 

 

Wait for the installation to finish, then click Next. 

 



In the next step, Sandboxie will install system drivers. Their installation is essential. Without these drivers 

Sandboxie will not work. Click the Next button. 

 

The installation of system drivers was the last step in the installation process. Exit the installer by clicking 

the Finish button. 

 



Sandboxie will start immediately after installation. At the first launch, the program will want to use the 

configuration files for some programs found on your system. He will ask for permission for their use. This is 

not necessary for our purposes, so at this point you can close the window by clicking X in the upper right 

corner of the window. 

 

A short tutorial will be displayed for those who are just starting their adventure with Sandboxie. It is 

advisable to read the hints in it. After the tutorial, click Done or Close. 

 

Sandboxie is already running. The program window looks like in the picture below: 



 

At the moment you can close it. We will not make any configurations in it, because the default program 

settings are enough for what we want to achieve. Closing the window with the X button in the upper right 

corner will minimize the window to the system bar, about which the program will inform you by displaying 

a message. 

 

The main program window will disappear, but the program will still run in the background, which will be 

represented by the yellow icon in the system tray, as shown below: 

 

Sandboxie is ready. Now we can launch iStripper in the sandbox. 

Using Sandboxie 



Sandboxie works in the background, which is indicated by the yellow icon in the system tray. You can 

already run iStripper in the sandbox. The first way: click on the yellow Sandboxie icon with the right mouse 

button and select: 

DeafultBox > Run From Start Menu  

 

You will see a list of programs installed on your computer. In the available list look for: 

Programs > iStripper > iStripper 

and click it to start the iStripper program in the sandbox. After a while, the second copy of iStripper opens. 

You should notice an additional iStripper icon in the system tray. 

 

Second way: locate a shortcut to iStripper (for example, in the Start menu, or a shortcut on the desktop, if 

any has been created), right-click on it and select Run Sandboxed. A window will appear in which you will 

be able to select a sandbox. 



 

Select the default sandbox (DefaultBox) and click OK. After a while, the second copy of iStripper will be 

launched. 

There is a possibility to run more sandboxes, and thus more instances (copies) of the iStripper program, but 

to do this you need to purchase a license for the Sandboxie program. The free version of Sandboxie allows 

you to create only one sandbox. 

Using iStripper 

Now that you have two copies of iStripper running (one in normal mode and one in the sandbox), you can 

control each one separately. Activate both copies of iStripper and play with the settings in each of the two 

iStripper interfaces (GUI). You can set different options in each copy of the program. After closing the 

iStripper program, the settings of each copy will be saved. 

 



If you have two monitors, to display one model on each monitor: click on the chosen model to switch her to 

small size, drag her and drop on the selected monitor, click her again to switch to full size. 

Pros: 

 you can display up to twenty models simultaneously in full size (ATTENTION: this setting can 

significantly slow down your computer!), 

 you can display two models in the full size, 

 if you have two screens, you can display one model in full size on each screen, 

 for each model displayed in full size, you can use separate settings (eg a different scale for each 

girl), 

 settings for each copy of the program will be saved and retained even after all copies of iStripper 

have been closed. 

Cons: 

 you can't change the position of the clips with drag'n'drop option. 

  

  



Duplicating processes - method using Process 

Explorer 

The method consists in running the iStripper program in many separate processes (separate instances). 

Normally, this is not possible because only one iStripper instance can work in the system. An attempt to run 

another "copy" of the program usually ends with the recall of the window of the first copy that was 

launched. 

This method is somewhat similar to the first method (using the sandbox), however, the method described 

here allows you to run any number of iStripper processes (more than two). 

To run multiple copies of iStripper, we will use a free tool called Process Explorer. The tool is available for 

download from Microsoft websites. It allows, among other things, to control the running processes and 

monitor the resources they use. 

 

Downloading Process Explorer 

To download Process Explorer open any web browser and go to: 

https://docs.microsoft.com/en-us/sysinternals/downloads/process-explorer 

Download the program by clicking the "Download Process Explorer" link, marked on the printscreen. 

 



Save the ProcessExplorer.zip file anywhere on your hard drive. 

Installation of the Process Explorer 

Open the folder where you downloaded ProcessExplorer.zip and extract the contents of the archive to any 

folder. Process Explorer does not really require installation. Just run it. 

Using Process Explorer 

If iStripper is closed, start it now. If you are using a 64-bit system, select 64-bit version of the Process 

Explorer (procexp64.exe), otherwise select the 32-bit version (procexp.exe). 

 

At the first launch you will be asked to accept the license terms. Click Agree. 



 

You will see the main application window. It displays a list of all processes running on your computer. In the 

process list, find the process named vghd.exe and select it. 

 

Leaving the process selected, display the bottom panel and the list of all handles. To do this, you can use 

the shortcut Ctrl+H or select in the main menu: 

View > Lower Pane View > Handles 



 

The bottom panel is divided into two columns: Type and Name. Scroll the panel until you see the Mutant 

type in the Type column: 

 

Select the handle with the following name: 



\Sessions\1\BaseNamedObjects\VghdMutex 

Right-click on it and close the handle by selecting Close Handle. 

 

A window will appear asking if you really want to do this. Confirm by clicking the Yes (Tak) button. 

 

Follow the same step with the next handle: 

\Sessions\1\BaseNamedObjects\QtLockedFile mutex c:/some_path/qtsingleapp-vghd-eafe-1-lockfile 

Select it, right-click, close the handle with the Close Handle command and confirm. Now try to run the 

second instance (copy) of the iStripper program. You will notice that after closing the two handles you can 

launch another copy of iStripper (note the second iStripper icon in the system tray). Alright, that's it. 



Let's try to run the third copy of iStripper now. To do this, you must first close the same two handles for the 

last opened vghd.exe process. Locate the last running vghd.exe process in the list of processes. At this 

moment two processes with the same name appear in the list. If you are not sure which one was opened 

last, you can check the start time of each of the vghd.exe processes. To do this, right-click on each of the 

processes and select Properties... 

 

The process start time is marked on the picture: 

 



Close the properties window and close the same two handles that you closed for the previous vghd.exe 

process, in other words: in the bottom panel find the Mutant types, find the two following handles: 

\Sessions\1\BaseNamedObjects\VghdMutex 

\Sessions\1\BaseNamedObjects\QtLockedFile mutex c:/some_path/qtsingleapp-vghd-eafe-1-lockfile 

right-click on each of them, choose Close Handle and confirm. Done. You can now start the third instance 

(copy) of iStripper. What if you want to run a fourth copy? Go ahead. Again, just close the same two 

handles for the last opened vghd.exe process. 

 

NOTE: be carefull with the number of copies being run. Too many running iStrippers can cause your 

computer to slow down significantly. 

Using iStripper 

Each additional duplicate of the vghd.exe process allows you to display an additional one model in full size 

or even ten models in small size. Thanks to a separate interface (GUI) you can control each of them 

separately. Activate all copies of iStripper and play with the settings in each GUI. You can set different 

options in each copy of the program. After closing all copies of the iStripper program, only the last selected 

settings are saved. 

 



If you have two monitors, to display one model on each monitor: click on the chosen model to switch her to 

small size, drag her and drop on the selected monitor, click her again to switch to full size. 

Pros: 

 you can display an additional ten models in small size for each running copy of iStripper (NOTE: this 

setting can slow down your computer considerably!), 

 you can display as many models in full size as iStripper copies are enabled, 

 if you have two or more monitors, you can display one model in full size on each of them, 

 for each model displayed in full size, you can use separate settings (eg different scale for each girl). 

Cons: 

 you can't change the position of the clips with drag'n'drop option, 

 you can't save separate settings for each copy of iStripper. 

 

  



Editing RAM content - method using Cheat 

Engine 

The method consists in changing the scale of models by editing values directly in the RAM memory. With 

this method, you only need to run one copy of iStripper. 

To edit the values stored in RAM, we will use the Cheat Engine program. It is a free tool designed to modify 

single-player games. It also allows you to debug applications as well as to inspect and change the memory 

content. This method will use the last of the listed functions. 

Thanks to MrEff and Wyldanimal for the idea with Cheat Engine program. 

NOTE: There is a Cheat Engine version for MAC users. Therefore, this method should work on MAC 

computers, but I can not be sure, I did't check. 

Downloading Cheat Engine 

To download Cheat Engine open any web browser and go to: 

http://www.cheatengine.org 

Download the installer by clicking the big button that says "Download Cheat Engine" (hard to miss). 

 

Save the installer (CheatEngine67.exe file) anywhere on your hard drive. 



NOTE: If your antivirus program finds the file malicious, do not worry about it. Download the file anyway. If 

necessary, temporarily disable your antivirus program. 

Installation of the Cheat Engine 

Go to the folder where you downloaded the CheatEngine67.exe file and run the installer by double-clicking 

it. Some antivirus programs recognize Cheat Engine as a virus or Trojan by mistake, blocking the ability to 

install. If this is your case, temporarily disable the antivirus protection or close the antivirus program for the 

time of installation. 

The installer will show up with a welcome screen. Click the Next button. 

 

 

 

 

 



Agree to the license terms and click Next. 

 

Point to the path to the folder where Cheat Engine will be installed. It is recommended to leave the default 

path. Click the Next button. 

 



The installer will inform you about the creation of shortcuts in the Start menu. You can check the "Don't 

create a Start Menu folder" option if you don't want those shortcuts. Click the Next button. 

 

The installer will ask you if he should create a shortcut to the program on your desktop. Agree to have easy 

access to the Cheat Engine. If you want Cheat Engine to look for updates, select "Check for new versions 

when starts". Click the Next button. 

 



ATTENTION: in the next step the installer will ask if you want to install additional third party software. Do 

not agree to this. Uncheck all consents and continue by clicking the Next button. 

 

Before installing the program, the installer will display a summary. Review them just in case. If you think all 

the settings are correct, click the Install button. 

 



After installing all components, the installer displays additional information that you can read (but you 

don't have to). Click the Next button. 

 

The installation has been completed. Leave the "Reset settings" and "Launch Cheat Engine" options 

selected and click the Finish button. 

 



At the first launch the program will suggest using the tutorial. For now, it is unnecessary, so click the 

No button. 

 

The Cheat Engine program will start and it will be ready to work. This is how its main window looks: 

 

Using Cheat Engine 

If iStripper is closed, start it now. In the Cheat Engine program, click on the computer icon around which 

the red and green frame flashes. You can also use the command in the main menu: 



File > Open Process 

 

A small window will open. Go to the Processes tab. In the list of processes find vghd.exe, select it, and then 

click Open. 

 



The program is ready to scan the memory used by the selected process. To scan RAM, you need to know 

more about what to look for. In this case, we focus on the size of the clips displayed by iStripper. Therefore, 

let's try to scan the memory for the scale that is currently set for models in small size. Open iStripper and 

go to settings. Set any scale for small size, e.g. 25%. Remember the number 25. 

 

Return to the Cheat Engine program and put the number to the Value field, then click the First Scan button. 

 

The program will find a dozen or even thousands addresses containing the given value. 



 

It's too much to manually search for the value we're interested in, so we'll filter the results. Go to the 

iStripper settings again and set the model scale (Small size) to something different, e.g. 15%. Remember the 

number 15. 

 

Go back to the Cheat Engine program and enter the new number in the Value field. This time click the 

Next Scan button. 



 

This time the program found three addresses containing the searched value. This is exactly what we need. 

Now think: how big models would you like to see on your monitor? 80 percent of the size? One hundred, or 

maybe even more? Let's start with 85%. In the Cheat Engine program, select the first of the three found 

addresses, right-click on it and select Change value of selected addresses or use the Ctrl+E shortcut. 



 

In the new small window, enter the new value you want to use. In this case, it will be 85. Enter it and 

confirm by clicking OK. 

 

Do the same for the other two addresses by changing all values to 85. 



 

Finished. Activate the iStripper now and play the show in small size to see the result. For a better effect, set 

the number of models to 3-5. 

Using iStripper 

Thanks to this method, you are able to display up to 10 models simultaneously at a scale of more than 60% 

(this is the maximum value allowed by iStripper in small size). Unfortunately, it is impossible to control the 

scale with the iStripper interface. Using the slider in iStripper will overwrite the memory and you will have 

to set the value you entered using the Cheat Engine again. In addition, the changes you make will not affect 

the currently playing clips. They will only be applied to the next clip. After closing the iStripper program and 

restarting it you will have to repeat whole process. 



 

Pros:  

 in the small size, you can display up to ten models simultaneously at a scale of more than 60%, 

 you can freely change the position of clips by drag and drop, so you can place models on several 

monitors, 

 you can watch transition clips in full scale. 

Cons: 

 you can't use separate settings for individual models, 

 you can't save the manually entered settings. 

  



Links 

The file was downloaded from: http://www.isworkshop.eu 

or: http://lukasr.net/projects/istripper 

General discussion: http://www.istripper.com/forum/thread/39125/1 

 

http://www.isworkshop.eu/
http://lukasr.net/projects/istripper
http://www.istripper.com/forum/thread/39125/1

